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About Brainware Intelligent Capture
Brainware Intelligent Capture (BIC) is a document processing system.

It combines optical character recognition (OCR), automatic data extraction from any document type, and
validation of that data against known data sources for auto-processing to your ECM system and other core
business applications.

Brainware Intelligent Capture includes the following applications.

l Brainware Intelligent Capture Designer
l Brainware Intelligent Capture Runtime Server
l Brainware Intelligent Capture Verifier
l Brainware Intelligent CaptureWeb Verifier

For information about the document processing system, see About the Brainware Intelligent Capture process.

Brainware API
The Brainware Intelligent Capture setup package includes the Brainware API installation files.

For more information, see theBrainware API Installation Guide.

Prerequisites
To verify your system requirements and databasemeet theminimum requirements for BIC, refer to the
Brainware Intelligent Capture Technical Specifications. Before you install BIC, verify the following
prerequisites.

l Ensure that you have local administrator rights and access to theWindows registry.
l Enable VBScript execution.
l Verify that you have installed Internet Information Services (IIS) on your server if your installation
will includeWeb Verifier.

l If you useOracle as a database, install a 32-bit Oracle client on any workstation or server where
BIC communicates with the database, such as when using Designer or Verifier.

l Create the users and groups if you use theMicrosoft-recommended resource rights assignment
model.
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About the Brainware Intelligent Capture process
Brainware Intelligent Capture (BIC) analyzes text from any media type. It uses artificial neural network
techniques to automatically classify structured and unstructured documents and extract meaningful
information from them. Once a sample based learningmethod is employed BIC can handle information that is
similar to the samples without programming or extensive rule setting. BIC can operate at high speed and can
be implemented on parallel hardware to further enhance performance.

BIC forms a complete document processing system, as illustrated in the diagram below

First, using capture, documents come into the process from a variety of sources.

Next, BIC recognizes all eligible data values on the page.
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Then, BIC uses the extracted data to sort and classify the documents. Based on the document type, BIC
extracts field-level and line item level data. It does this without templates, anchors, keywords or zones.

Finally, BIC can validate extracted data against your business application data to ensure accuracy before
exporting it for workflow processing.

About the Brainware Intelligent Capture database
The BIC installation process allows you to create the required database on your Microsoft SQL Server or
ORACLE server during the installation. You can also create the database separately after the BIC installation
procedure.

BIC stores the following data in the database.

l Documents
l Batches
l Project references
l WebVerifier configuration
l Batch and document lock handling
l Users, groups, roles, and relationships
l Application level user licensing

Install Brainware Intelligent Capture
To install BIC, complete the following procedures.

l Download the setup package
l Optional. Modify the help file location
l Optional. Complete one of the following substeps to verify database permissions.

Note:
To create the database during BIC installation, youmust have user credentials which have the
proper permissions.

l Verify SQL Server permissions

l Verify Oracle permissions

l Install BIC attended or Install BIC unattended
l Optional. Modify the application-specific HelpLink parameters
l If you did not install the database with the installation wizard, complete the steps in Install the
databasemanually.

l Optional. Encrypt the password for a database connection string.
l Copy the license file. For more information, see "Copy the license file to local license directories" in
theBrainware Intelligent Capture Product Licensing Guide.

l Configure Internet Information Services andWeb Verifier, if the installation includes Web Verifier
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l Configure BIC security
l Configure BIC Runtime Components

Download the setup package
To obtain Perceptive product installation files, complete the following steps.

1. Contact the Hyland Software Technical Support group.
For a list of Technical Support phone numbers, go to www.hyland.com/pswtscontact.

2. Save and unzip the installation files locally so you can access them during installation.

About the complete and custom installation types
When you install BIC with an attended installation, you choose a complete or a custom installation type.

The complete option installs Designer, Runtime Server, Verifier andWeb Verifier in the [drive:]\[Program
directory]\[Installation directory] and creates the Brainware Intelligent Capture program group. It also installs
the following recognition engines.

l FineReader 10
l FineReader 11
l Kadmos 5
l QualitySoft

The custom installation type allows you to choose which applications, demo projects, and recognition engines
you want to install. It also lets you select which programs you want to update automatically.

About Help files
By default, the Brainware Intelligent Capture products provide hosted product help, which enables you to
always access themost recent information directly from the documentation website. If your company’s
network security does not allow users to open a URL, you can download static help through the Customer
Portal. To implement static help instead of hosted help, youmust modify the configuration.

The SetupType.ini file enables you to specify the path and file that the BIC application opens when you click
Help in the Helpmenu of a particular product. You can place the files on a web server and specify the URL to
the file that launches Help for that product or you can unzip the files on a local or a server drive, and use that
file path.

HelpLink parameters

You can redirect product help from the default web URLs to a file on your system.

The HelpLink variable is a label that applies to a particular product. The products that provide help include:
Designer, RTS, Verifier, Learnset Manager, andWeb Verifier.

The syntax includes the HelpLink type, which defines the product, and the path to the static file location.

HelpLink = [path]/PIC.htm#5.9

HelpLink_Designer = [path]/PICD.htm
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HelpLink_RTS = [path]/PICRS.htm

HelpLink_Verifier = [path]/PICV.htm

HelpLink_LSM = [path]/PICV.htm#Topics/Verifier/Working with the Learnset
Manager.htm

HelpLink_WebVerifier = [path]/PICWV.htm

For path, supply the URL or path (absolute or relative) to the launch file for that specific help project. The
following examples show aURL, a network path, and a local path.

l HelpLink_Designer = https://docs.mycompany.com/mypath/Designer/PICD.htm

l HelpLink_Designer = \\myserver\mypath\Designer\PICD.htm

l HelpLink_Designer = C:/mypath/Designer/PICD.htm

Modify SetupType.ini for Help

Tomodify the SetupType.ini file, complete the following steps.

1. From the setup directory, open theSetupType.ini file with a text editor.
2. In theSetupType.ini file, in the [Help] section, specify the path for each HelpLink. The following

lines show sample URLs to the hosted documentation.

Example
HelpLink_Designer =
https://docs.mycompany.com/mypath/Designer/PICD.htm

HelpLink_RTS = https://docs.mycompany.com/mypath/Runtime_
Server/PICRS.htm

HelpLink_Verifier =
https://docs.mycompany.com/mypath/Verifier/PICV.htm

HelpLink_WebVerifier = https://docs.mycompany.com/mypath/Web_
Verifier/PICWV.htm

3. Save and close the file.

Verify SQL Server permissions
To use BIC with a SQL Server database, verify that your account has the following rights.

Note: You can useWindows authentication if the user performing the installation has the appropriate rights
to the database server.

l Rights to create, modify, and delete tables.
l Rights to add, modify, and delete data.
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Verify Oracle permissions
To use BIC with anORACLE database, complete the following preparatory steps.

Note:
You can useWindows authentication if the user performing the installation has administrative rights to the
database server.

1. As an administrator, create a new tablespace and user for the BIC database.

Note:
The user namemust be all-uppercase.

2. Assign the following rights to the user.
l Insert, modify, and delete data
l Create tables
l Create views

Install BIC attended
To install BIC, complete the following steps.

1. Run setup.exe.

Note: The installation process is available in English andGerman. The language used depends
on the regional settings of your system. The default language is English.

2. If .NET Framework 4.6 is not installed, complete one of the following substeps.
l To allow setup.exe to install .NET Framework 4.6, select Let the setup install .NET
Framework Version 4.6 (Recommended) and then click Next.

Note:
The .NET Framework installer automatically restarts the computer without further
notification.

l To cancel the setup and install the required .NET Framework manually, select Abort
setup and then click Next. After installing .NET Framework, rerun setup.exe and
proceed with the following steps.

3. In theSetup Hyland Brainware Intelligent Capture page, click Next.
4. In the License Agreement page, read and accept the End-User License Agreement (EULA), and

then click Next.
5. In the Installation Type page, select Complete orCustom and click Next.
6. If you selectedCustom, complete the following substeps. If you selectedComplete, continue to

the next step.
1. In the Installation Directory page, accept the default or change the directory, and then
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click Next.
2. In the Feature Selection page, clear any unrequired applications, demo projects, and

recognition engines and then click Next.
3. Optional. In theConfiguration of Auto Update Feature page, select the programs you

want to update automatically.
4. The following option is currently not in use: Optional. In theShared network updates

directory field, type or browse to a path.

Note: The pathmust exist. The installation process uses this path to create and
configure the batch files required for the automated update feature.

5. Click Next.
7. In theProgram Folder page, accept the default program directory or select one of the existing

directories and then click Next.
8. In theSelected Install Options page, verify your selections and then click Next.
9. In theWIBU-KEY Runtime-Kit dialog box, click Yes.
10. In theDatabase Setup Options page, select one of the following options and then click Next.

l SQLServer
l Oracle
l Do not install database

Note: You can create the database separately after the BIC installation process.

11. For SQL Server or ORACLE, complete the following substeps.
1. In the Login Credentials page, either selectWindows Authentication or type the user

ID and password and then click Next.
2. In theDatabase Server Information page, in theDatabase Server Name field, type

the database server name and then click Next.
12. In thePerformed Tasks page, click Next.
13. Optional. In the Icons on Desktop page, select Create desktop shortcuts for applications and

click Finish.

Install BIC unattended
To install BIC on several machines concurrently, such as Verifier workstations, use the silent installation
mode.
To install BIC silently, complete the following steps.

1. From the [drive:]\[setup directory] directory, open theSilent Install.ini file with a text editor.
2. In theSilent Install.ini file, change the parameters according to your needs.

Note: You can delete single parameters or complete sections, but you cannot move a parameter
outside of its appropriate section.
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3. Save and close the file.
4. From the [drive:]\[setup directory] directory, execute the setupsilent.bat file.

Silent Install.ini parameters

The following topics describe the parameters available in the Silent Install.ini file.

l [General]
l [Applications]
l [OCR Engines]
l [Additional]
l [AutoServiceUpdate]
l [Database Configuration]
l [DB Credentials]

[General]

This section contains general installation parameters.

Path

The installation path, without a trailing backslash.

Example

Path = C:\Program Files\YourCompanyName

EULA

End-user license agreement The following values are recognized:

“Accepted”

“Not Accepted”: Default value - the silent installation cancels.

MoveComponentsIfRequired

Indicates whether to use the existing component directory or to move any previous components to the
new BIC directory prior to installation.

0: Use existing component directory.

1: Default value –Move components to the new directory.

CreateDeskTopIcons

0: Default value – do not create desktop shortcuts.

1: Create desktop shortcuts.
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InstallWibuKey

0: SkipWIBU-key driver installation.

1: Default value - install WIBU-key drivers

StopIfDotNetIsNotFound

WebVerifier and the database connections require .NET Framework.

0: If the required .NET Framework is not present, the installation proceeds and automatically installs the
required version.

1: Default value - Cancel the installation if the required .NET Framework version is not present.

[Applications]

Defines which applications to install.
To install only the extraction components, set all parameters in this section to 0.

Designer

0: Don’t install Designer

1: Default value – Install Designer

Verifier

0: Don’t install Verifier

1: Default value – Install Verifier

Runtime Server

0: Don’t install Runtime Server

1: Default value – Install Runtime Server

Web Verifier

0: Don’t install Web Verifier

1: Default value – Install Web Verifier

[OCR Engines]

Defines which OCR engines to install.

FineReader10

0: Don’t install the FineReader10 engine

1: Default value – Install FineReader10 engine
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FineReader11

0: Don’t install the FineReader11 engine

1: Default value – Install FineReader11 engine

Kadmos5

0: Don’t install the Kadmos 5 engine

1: Default value – Install Kadmos 5 engine

Cleqs

0: Don’t install the Cleqs engine

1: Default value – Install Cleqs engine

QualitysoftBarcode

0: Don’t install the QualitySoft engine

1: Default value – Install QualitySoft engine

[Additional]

Additional files to install.

Demo Files

0: Don’t install the demo project files

1: Default value – Install the demo project files

[AutoServiceUpdate]

Defines whether the automatic service update feature installs.

ForDesigner

0: Default value – Don’t define an automatic service update for Designer.

1: Define an automatic service update for Designer.

ForVerifier

0: Default value – Don’t define an automatic service update for Verifier.

1: Define an automatic service update for Verifier.

NetworkUpdateFolder

The path where the automatic service update will look for updates.

The default value is an empty string.
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[Database Configuration]

Settings for an existing database server.

DBServerType

1: Configure the SQL Server database

2: Configure the Oracle database

3: Default value – Don’t configure a database

UseDBConfIniFile

Path and filename of a text file that contains the database connection string.

The default value is an empty string. If you do not define a file, the installer uses the credentials in the
[DB Credentials] section. If the [DB Credentials] section does not exist, the DBServerType parameter
defaults to 3.

[DB Credentials]

You can use this section instead of defining a file in the parameter UseDBConfIniFile.

Note: The database configuration skips, if the parameter UseDBConfIniFile contains an empty string.

The following options apply for SQL Server connections only.

SQLServerWindowsAuthent

0: Default value – Do not useWindows authentication for database access

1: UseWindows authentication for database access

SQLServerAdminUser

The DBA account name. The default value is an empty string.

SQLServerAdminPassword

The DBA account password. The default value is an empty string

The following options apply for both SQL Server andORACLE connections.

DBUserWindowsAuthent

0: Default value – Do not useWindows authentication for database user

1: UseWindows authentication for the database user

DBUserName

The database user account name. The default value is an empty string.
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DBUserPassword

The database user account password. The default value is an empty string.

DatabaseServerPath

The database name in the format <MachineName>\<InstanceName>. The default value is an empty
string.

Install an additional Runtime Server instance
To install an additional Runtime Server instance and connect it to an existing database, complete the
following steps.

1. Install BIC without installing the database.
2. Copy the following configuration files from an existing installation to the new installation directory.

l [Installation path]\Brainware Intelligent CaptureWeb Server\Web.config
l [Installation path]\Brainware Intelligent Capture\bin\DstDsr.exe.config
l [Installation path]\Brainware Intelligent Capture\bin\DstHost.exe.config
l [Installation path]\Brainware Intelligent Capture\bin\DstSlm.exe.config
l [Installation path]\Brainware Intelligent Capture\bin\DstVer.exe.config
l [Installation path]\Brainware Intelligent Capture\bin\DstWkBrw.exe.config

Brainware Intelligent Capture subdirectories
Setup creates the following subdirectories in the installation directory.

l \Components\Bwe contains the BIC Toolkit.
l \Components\Cairo contains the license file and the base components for imaging and recognition.
l \Components\Cedar contains the base components for document analysis.
l \Components\Tools contains the installation log file as well as several tools and utilities for BIC,
such as the SCBLibVersion.exe component version information tool

l \Brainware Intelligent Capture\bin contains the BIC executables and the settings files.
l \Brainware Intelligent Capture\bin\Log contains the log files.
l \Brainware Intelligent CaptureWeb Server contains the BIC web components, theWeb.config file,
and other web libraries used by Web Verifier.

l \Projects contains demo projects.
l \License contains the shared runtime license file.

Modify the application-specific HelpLink parameters
You canmodify the application-specific HelpLink parameters if required. Complete the following steps.

1. From [Installation path]\Brainware Intelligent Capture\bin, open the required configuration file,
such as DstDsr.exe.config for Designer, in a text editor.

2. Search for the following line.
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<add key="HelpLink"

3. Modify the value parameter according to your needs.

CONFIG files
The following table provides a list of the CONFIG files used by the BIC applications.

Application CONFIG files

Designer [Installation path]\Brainware Intelligent Capture\bin\DstDsr.exe.config

Runtime Server [Installation path]\Brainware Intelligent Capture\bin\DstHost.exe.config

Learnset Manager [Installation path]\Brainware Intelligent Capture\bin\DstSlm.exe.config

Verifier [Installation path]\Brainware Intelligent Capture\bin\DstVer.exe.config

Web Verifier [Installation path]\Brainware Intelligent CaptureWeb Server\Web.config

Workdoc Browser [Installation path]\Brainware Intelligent Capture\bin\DstWkBrw.exe.config

Supervised Learning in Web
Verifier

[Installation path]\Brainware Intelligent
Capture\bin\Brainware.System.Project.exe.config

Install the databasemanually
If you did not install the database with the installation wizard, you can execute the scripts manually. Complete
the following steps.

1. Complete one of the following substeps.
l Create a SQL Server database.

l Create anOracle database.

2. Modify the database connection strings.
3. If you useOracle as a database, modify the .NET configuration for Oracle.

Create a SQL Server database

To create a SQL Server database, complete the following steps.

1. Start theSQL Server Management Studio.
2. Log in using an account with administrator rights.
3. Create a new database with ameaningful name, such as Brainware Intelligent Capture.
4. From the [drive:]\[setup directory]\FirstPart\Database\CreationScripts\SQL Server directory,

execute theBrwCreateDatabase.sql script.
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5. From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\SQL Server directory,
open theBRW_Upgrade_Database.sql script.

6. In theBRW_Upgrade_Database.sql script, search for the term TargetDatabaseName and
change the term to the name of your BIC database.

7. Execute theBRW_Upgrade_Database.sql script.

Create an Oracle database

To create anOracle database, complete the following steps.

1. As an administrator, create a new tablespace and user for the BIC database.

Note:
The user namemust be all-uppercase.

2. Start SQL*Plus or the ORACLE Management Console.
3. From the [drive:]\[setup directory]\FirstPart\Database\CreationScripts\Oracle directory,

execute theBrwCreateDatabase.sql script.
4. From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\Oracle directory, open

theBRW_Upgrade_Database.sql script.
5. In theBRW_Upgrade_Database.sql script, search for the term TargetDBSchemaName and

change it to the name of the user associated to the BIC database.
6. Execute theBRW_Upgrade_Database.sql script.

Modify the database connection strings

Tomodify the database connection strings forWeb Verifier, see “Modify the database connection strings for
Web Verifier”.
Tomodify the database connection strings for all BIC components, except Web Verifier, complete the
following steps.

1. From the [Installation path]\Brainware Intelligent Capture\bin directory, open
DstDsr.exe.config in a text editor.

2. Search for the <connectionStrings> element.

Note:
For information about password encryption, see Encrypt the password for a database
connection string.

3. For a SQL Server database, modify the following values.
l Set Data Source.
l Set Initial Catalog to the SQL Server database catalog.
l Set User ID to the SQL Server user ID.
l Set Password to the SQL Server password.

Example
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<connectionStrings>
<add name="Entities"

connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity
.Entities.ssdl|r
es://*/Entity.Entities.msl; provider=System.Data.SqlClient;provider
connection
string=&quot;Data Source=<DataSource>;Initial
Catalog=<SQLServerDatabaseCatalog>;Integrated Security=false;User

ID=<UserId>;Password=<UserPassword>;MultipleActiveResultSets=True&quo
t;"
providerName="System.Data.EntityClient" />
</connectionStrings>

Note: To copy the connections string example as a single line, open this document in Acrobat
Reader and copy and paste the string from there.

4. For anORACLE database, modify the following values.
l Set Data Source.
l Set User ID to the service account user ID.
l Set Password to the service account password.

Example

<connectionStrings>
<add name="Entities"

connectionString="metadata=res://*/Entity.ORAEntities.csdl|res://*/Ent
ity.ORAEntities.
ssdl|res://*/Entity.ORAEntities.msl; provider=EFOracleProvider;
Provider Connection
String='Data Source=<OracleServerName\InstanceName>;User
ID=<UserID>;Password=<UserPassword>'"
providerName="System.Data.EntityClient" />
</connectionStrings>

Note: To copy the connections string example as a single line, open this document in Acrobat
Reader and copy and paste the string from there.

5. Save and close the file.
6. Repeat the previous steps for the following configuration files.

l Brainware.System.Project.exe.config
l DstSlm.exe.config
l DstVer.exe.config
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l DstHost.exe.config
l DstWkBrw.exe.config

Modify the .NET configuration for Oracle

If you use BIC with anOracle database, complete the following steps.

1. From <drive>:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\CONFIG, open
machine.config in a text editor.

2. Search for the <system.data> element.
3. Under the <DbProviderFactories> element, verify or add the following element.

Example

<add name="EF Oracle Data Provider" invariant="EFOracleProvider"
description="EF
Provider for Oracle" type="EFOracleProvider.EFOracleProviderFactory,
EFOracleProvider, Version=1.0.0.0, Culture=neutral,
PublicKeyToken=def642f226e0e59b"/>

Note: To copy this example as a single line, open this document in Acrobat Reader and copy
and paste the string from there.

4. Save and close the file.

Components Version Info tool
The Components Version Info tool provides information about the installed DLLs and the components that
require an entry in the license file to be available.

Components General Info view
This view lists the installed primary DLLs and provides the following information.

See also: Review the installed components.

l Name. Name of the installed DLL.
l Description. Description of the DLL.
l Build. Build number of the DLL.
l Product version. Version of the DLL.
l Date. Compilation date and time.
l Build Date Time. Date and time the build was created.
l Install Directory. Path to the component location.

Components Licensing Info view
This view lists licensable components and provides the following information.

See also: Review the component license information.
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l Component Name. Name of the component.
l Component Type. Type of the component.
l Status. License status of the component.
l License File Path. License file location.
l License Files. License file name.
l Expires. License expiration date for component.
l Version. Version number.
l Customer. Customer name.
l Customer ID. Customer ID.
l Serial. Serial number.

Review the installed components
To review the installed components, complete the following steps.

1. Start theComponents Version Info tool.
2. To display the list of installed components, click View > Components General Info.
3. Optional. To copy the displayed information to the clipboard, click File > Copy to Clipboard.
4. Optional. To save the displayed information to a file, click File > Save to File.

Review the component license information
To review the component license information, complete the following steps.

1. Start theComponents Version Info tool.
2. To display the license information, click View > Components Licensing Info.

Manage the BIC components
The BIC installation process enables you to add or remove the following components.

l Brainware Intelligent Capture Designer
l Brainware Intelligent Capture Runtime Server
l Brainware Intelligent Capture Verifier
l Brainware Intelligent CaptureWeb Verifier

Add or remove BIC components
Tomodify an existing Brainware Intelligent Capture installation and to add or remove components, complete
the following steps.

1. FromWindows Programs and Features, select Brainware Intelligent Capture and then click
Change.

2. In the License Agreement page, read and accept the End-User License Agreement (EULA), and
then click Next.

3. In theSetup page, selectModify and then click Next.
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4. In the Feature Selection page, select or clear the desired components and then click Next.
5. In the Icons on Desktop page, complete the following substeps.

1. Optional. Select Create desktop shortcuts for applications.
2. Click Finish.

Manually register components
The installation process automatically registers the Cro*.dll, Cdr*.dll, and Bwe*.dll components. For
troubleshooting purposes, you canmanually register these components. To register the components,
complete the following steps.

1. From the [Installation path]\Brainware Intelligent Capture\Components\Cairo directory, execute the
RegCro.bat file.

2. From the [Installation path]\Brainware Intelligent Capture\Components\Cedar directory, execute
theRegCdr.bat file.

3. From the [Installation path]\Brainware Intelligent Capture\Components\Bwe directory, execute the
RegBwe.bat file.

Configuration for Web Verifier
Your Internet Information Server (IIS) executes Web Verifier. To configure IIS andWeb Verifier, complete the
following tasks as necessary.

l Configure IIS forWeb Verifier
l ConfigureWeb Verifier
l Configure server security forWeb Verifier
l Configure Internet Explorer forWeb Verifier
l Optional. Implement single sign-on authentication
l Optional. ConfigureWindows authentication
l Optional. Configure SSL. For information on how to configure SSL on your IIS machine, refer to
http://support.microsoft.com.

l Optional. Configure cookies forWeb Verifier

Configure IIS for Web Verifier
To configure IIS forWeb Verifier, complete the following tasks.

l Ensure that the required role services are enabled.
l Create an application pool for BIC in IIS 7.5 and above
l Configure BIC in IIS 7.5 and above
l Configure a white label directory in IIS
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Role services configuration for Web Verifier in IIS 7.5 and above

WebVerifier requires the following role services in IIS.

Common HTTP Features

l Static Content
l Default Document
l Directory Browsing
l HTTP Errors

Application Development

l ASP.NET 4.6 (ASP.NET 4.5 for operating system earlier thanWindows Server 2016)
l .NET Extensibility
l ISAPI Extensions
l ISAPI Filters

Health and Diagnostics

l HTTP Logging
l Request Monitor

Create an application pool for BIC in IIS 7.5 and above

To create an application pool, complete the following steps.

1. Start Internet Information Services (IIS) Manager.
2. In the Internet Information Services (IIS) Managerwindow, in the left pane, right-click the local

computer and then click Switch to Content View.
3. In themiddle pane, right-click Application Pools and then click Add Application Pool.
4. In theAdd Application Pool dialog box, complete the following substeps.

1. In theName field, type WebVerifierPool.
2. From the .NET CLR version list, select .NET CLR v4.0.30319 and then click OK.

5. In the left pane, click Application Pools.
6. In themiddle pane, right-clickWebVerifierPool and then click Advanced Settings.
7. In theAdvanced Settings dialog box, provide the following settings and then click OK.

l Enable 32-Bit Applications = True
l Managed PipelineMode = Integrated
l Identity = NetworkService
l Load User Profile = True
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Configure BIC in IIS 7.5 and above

To configure BIC in IIS 7.5 and above, complete the following steps.

1. Start Internet Information Services (IIS) Manager.
2. In the Internet Information Services (IIS) Managerwindow, in the left pane, expandSites >

Default Web Site.
3. Right-click Default Web Site and then click Add Application.
4. In theAdd Application dialog box, complete the following substeps.

1. In theAlias field, type WebVerifier.
2. In theApplication pool field, select the pool that was configured before, such as

WebVerifierPool.
3. In thePhysical path field, type or browse to the [Installation path]\Brainware

Intelligent Capture Web Server directory and then click OK.
5. In the Internet Information Services (IIS) Managerwindow, in the left pane, selectWebVerifier.
6. In themiddle pane, under IIS, double-click Default Document.
7. In the right pane, click Add.
8. In theAdd Default Document dialog box, in the Name field, type Login.aspx and then click

OK.

Configure a white label directory in IIS

If you are using a BIC version that contains a white label (WL) directory inside the Components\Cedar
directory, create aWL virtual directory in IIS. Complete the following steps.

1. In the Internet Information Services (IIS) Managerwindow, in the left pane, open the tree view
untilWeb Verifier displays.

2. Right-clickWeb Verifier, then click Add Virtual Directory.
3. In theAdd Virtual Directory dialog box, complete the following substeps.

1. In theAlias field, type WL as the name for the virtual directory.
2. In thePhysical path field, type or browse to the [Installation path]\Brainware

Intelligent Capture\Components\Cedar\WL directory and then click OK.

ConfigureWeb Verifier
To configureWeb Verifier, complete the following tasks.

1. Set the path to the license file.
2. Modify the instanceNamewhen usingmultiple web servers.
3. Modify the database connection strings forWeb Verifier.
4. To enhance application performance, you can optionally enable HTTP compression. For more

information, refer to Microsoft Technet.
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Set the path to the license file

To set the path to the license file, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, openWeb.config
in a text editor.

2. Search for the following line.
<project licensePath="[Installation path]\Brainware Intelligent
Capture\License\Runtime.lic"

3. Set the licensePath value to your license file location.
4. Save and close the file.

Modify the instanceName when using multiple web servers

To ensure that the instanceName value in theWeb.config is unique across all web servers accessing the
same BIC database, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, openWeb.config
in a text editor.

2. Search for the following XML elements.
<system.controllers><client instanceName="Web Verifier"
remoteObjectRenewalTimeout="180"></client>

3. Change instanceName="Web Verifier" to instanceName="Web Verifier [xx]"
with xx being unique across the system.

Example instanceName="Web Verifier 01" for the first server.

Example instanceName="Web Verifier 02" for the second server.

Modify the database connection strings for Web Verifier

Tomodify the database connection string, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, open the
Web.config file in a text editor.

2. Search for the <connectionStrings> element.
3. For a SQL Server database, modify the following values.

l Set Data Source to the data source.
l Set Initial Catalog to the SQL Server database catalog.
l Set User ID to the service account user ID.
l Set Password to the service account password.

4. For anORACLE database, modify the following values.
l Set Data Source to the data source.
l Set User ID to the service account user ID.
l Set Password to the service account password.

5. Save and close the file.
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6. Create a copy of theWeb.config file andmove it to [Installation path]\Brainware Intelligent
Capture\bin.

7. Rename theWeb.config file copy toBrainware.System.Project.exe.config.

Configure server security for Web Verifier
To configure server security forWeb Verifier, complete the following tasks as necessary.

1. Add the user context in SQL Server
2. Verify the IIS settings
3. Set permissions for BIC projects

Add the user context in SQL Server

To useWeb Verifier, your users need access rights for the SQL Server database with theWeb Verifier user
context. The default user context is Network Service.

Note: If you log in to the SQL Server usingWindows authentication, you need to add the domain username
to the SQL Server database in addition to the NT Authority/Network Service.

To add the Network Service user context to the SQL Server, complete the following steps.

1. InMicrosoft SQL Server Management Studio, in the left pane, click Security > Logins.
2. Right-click Logins and then click New Login.
3. In the Login dialog box, click Search.
4. In theSelect User or Group dialog box, in theEnter the object name to select field, type

NETWORK SERVICE, click Check Names and then click OK.
5. In the Login dialog box, in the left pane, click Server Roles.
6. In the right pane, underServer roles, select sysadmin and then click OK.

Verify the IIS settings

To verify that the IIS runs under NT Authority\Network Service, complete the following steps.

1. In Internet Information Services (IIS) Manager, in theConnections pane, open the server node
and then click Application Pools.

2. In theApplication Pools pane, right-clickWeb Verifier Pool and then click Advanced Settings.
3. In theAdvanced Settings dialog box, under Process Model, verify that the Identity property has

the value NetworkService.

Set permissions for BIC projects

BIC stores all projects in a file system directory. To enableWeb Verifier to load projects, youmust assign
appropriate permissions for the project directory.
To grant permission to the Network Service user for the project directory, complete the following steps.

1. InWindows Explorer, right-click your projects directory and then click Properties.
2. In theProperties dialog box, on theSecurity tab, click Edit.
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3. In thePermissions dialog box, click Add.
4. In theSelect Users, Computers, Service Accounts, or Groups dialog box, in theEnter the

object names to select field, type NETWORK SERVICE, click Check Names and then click OK.

Configure Internet Explorer for Web Verifier
To configure Internet Explorer forWeb Verifier, complete the following steps.

1. In Internet Explorer, click Tools > Internet Options.
2. In Internet Options dialog box, on theSecurity tab, click Custom level.
3. In theSecurity Settings dialog box, underActiveX controls and plug-ins, enable the following

settings.
l Binary and script behaviors
l Run ActiveX controls and plug-ins

4. UnderScripting, enable the following settings.
l Active scripting
l Allow status bar updates via script

Note: This setting allows Web Verifier to display information on batches, documents, current
filters, and page numbers in the Internet Explorer status bar.

Implement single sign-on authentication
To enable single sign-on authentication, complete the following tasks as necessary.

1. Enable the single sign-on authentication.
2. Modify theWeb Verifier session timeout.

About the single sign-on authentication for Web Verifier

WebVerifier supports single sign-on (SSO) user authentication. SSO intercepts the login request and either
gathers the user credentials, or accepts the user as already authenticated.

BIC provides the SSO functionality as a generic solution. It works with any SSO implementation and
configuration that provides the user credential information through an HTTP header. SSO support was tested
using Shibboleth 2.x which builds on SAML 2.0 standards.

For information on configuring the SSO service provider, refer to your provider’s product documentation.

Enable the single sign-on authentication

To enable single sign-on authentication, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, openWeb.config
in a text editor.

2. Search for the <httpHeaderBasedSso> element and complete the following substeps.
1. Set the enabled attribute to true.
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2. Set the loginHeader attribute to the HTTP header attribute name that the SSO
service returns.

3. Set the sessionHeader attribute to the default session-ID header that the SSO
service returns.

Example

<httpHeaderBasedSso loginHeader="remoteuser" enabled="true"
sessionHeader="ShibSessionID" />

3. Save and close the file.

About the single sign-on session and the Web Verifier session

Using SSO involves two different sessions: the SSO session and theWeb Verifier session.

To prevent verifier data loss, the SSO session should have a longer timeout than theWeb Verifier session.

The SSO andWeb Verifier sessions renew with every server request, such as field validation or opening a
batch. The sessions do not renew with client-side actions, such as zooming in on an image or typing a value
into a form field without validating it.

For details on how to configure the SSO session timeout, refer to your SSO provider documentation.

Modify the Web Verifier session timeout

Tomodify theWeb Verifier session timeout, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, open the
Web.config file in a text editor.

2. Search for the <sessionState> element.
3. Set the timeout attribute, in minutes, according to your needs.

ConfigureWindows authentication
To configureWindows authentication, complete the following tasks as necessary.

1. ConfigureWindows authentication in IIS 7.5 and higher .
2. Create aWindows authentication-version of theWeb.config file .
3. Switch back to Forms authentication.

About Windows authentication for Web Verifier

WebVerifier allows you to log in usingWindows authentication instead of Forms authentication.

After you configure this option, your users will only be able to log in withWindows authentication.

However, you can use the re-login menu option to login with an account other than yourWindows user
account, for example as an administrator, to perform certain administrative tasks.
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Configure Windows authentication in IIS 7.5 and higher

To configureWindows authentication for theWeb Verifier in IIS 7.5 and higher, complete the following steps.

Prerequisite
Add theWindows user to the BIC database.

1. In the Internet Information Services (IIS) Managerwindow, in the left pane, open the tree view
untilWeb Verifier displays.

2. ClickWeb Verifier and then, in themiddle pane, under IIS, double-click Authentication.
3. In theAuthentication pane, enableWindows Authentication and disable all other authentication

methods.
4. Restart any open browser sessions.

Create a Windows authentication-version of the Web.config file

We recommendmaintaining two versions of theWeb.config file to simplify switching between the default
Forms authentication andWindows authenticationmethods.
To create a copy of the default Web.config file andmodify it forWindows authentication, complete the
following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, create a backup of
theWeb.config file for the Forms authenticationmethod.

Note: You can store this backupWeb.config for Forms authentication in any directory.

2. Open the originalWeb.config file in a text editor.
3. Complete the following substeps.

1. Search for the following line.
<authentication mode="Forms">

2. Replace Forms with Windows.
<authentication mode="Windows">

3. Remove the following line.
<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx" />

4. Under the <authorization> node, replace the <deny users="?"/> element with
an <allow users="?"/> element.

5. Under the <pages> node, add an <pages enableSessionState="true">
element.

6. Remove all <location path=> nodes.
7. Save and close the file.

Switch back to Forms authentication

To switch fromWindows authenticationmode back to default Forms authentication, complete the following
steps.

1. OpenAdministrative Tools and then double-click Internet Information Services (IIS) Manager.
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2. In the Internet Information Services (IIS) Managerwindow, in the left pane, open the tree view
untilWeb Verifier displays.

3. ClickWebVerifier and then, in themiddle pane, under IIS, double-click Authentication.
4. In theAuthentication pane, disableWindows Authentication and enableAnonymous

Authentication and Forms Authentication.
5. Copy the backed upWeb.config file to the [Installation path]\Brainware Intelligent Capture

Web Server directory.
6. Restart any open browser sessions.

Configure cookies for Web Verifier
To ensure that the browser sends cookies over a secure https network only, complete the following steps.

Prerequisite
Configure SSL on the server.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, open the
Web.config file in a text editor.

2. In the <configuration> element, search for the following line.
<system.web>

3. Under <system.web>, add the following line.
<httpCookies requireSSL="true" />

4. To apply forms authentication, search for the following line.
<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx" />

5. Add the requireSSL attribute.
<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx"
requireSSL="true" />

6. Save and close the file.
7. Optional. To prevent other applications from accessingWeb Verifier cookies, deploy Web Verifier

in one of the following ways.
l As the root level website.
l As the only web application under a website in IIS.

AboutWeb Verifier performance
Consider the following information to improveWeb Verifier performance.

Image conversion

Opening documents inWeb Verifier that failed during classification or extractionmay cause performance
issues. The Runtime Server properties provide the following settings to convert failed images to PNG to
speed up the loading time.
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l Convert image to display format after failed classification

l Convert image to display format after failed extraction

For more information, see "About display formats" and "Set display format" in theBrainware Intelligent
Capture Runtime Server Help.

Remote Matching Service

The RemoteMatching Service (RMS) is an implementation of the Associative Search Engine. RMS is
capable of supporting large search data pools and is highly recommended for BIC installations includingWeb
Verifier.

For more information, see "Associative Search Engine" in theBrainware Intelligent Capture Designer Help.

Delayed validation

The "Allow delayed validation" feature increases the validation performance in Verifier andWeb Verifier by
reducing the number of server requests.

For more information, see "About delayed validation" and "Modify the validation rules for a field" in the
Brainware Intelligent Capture Designer Help.

Use Traditional Chinese
If you choose Chinese as UI language, Web Verifier uses Simplified Chinese by default.
To change to Traditional Chinese, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server\bin\Resources directory,
create a backup copy of the zho directory.

2. Copy all files from the [Installation path]\Brainware Intelligent CaptureWeb
Server\bin\Resources\cmn directory to the [Installation path]Brainware Intelligent CaptureWeb
Server\bin\Resources\zho directory.

3. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, open the
Web.config file in a text editor.

4. Search for the following line.
<add key="LanguageDisplayName_ZHO" value="中文简体" />

5. Modify the line as follows.
<add key="LanguageDisplayName_CMN" value="中文繁體" />

6. Save and close the file.
7. Restart any open browser sessions.

AccessWeb Verifier
To access Web Verifier, complete the following step.

l In your browser, type http://localhost/WebVerifier/login.aspx.
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Additional columns in Verifier or Web Verifier
You can display additional columns in Verifier andWeb Verifier. If you display the external group ID column,
verify that the group ID matches the group ID you created for the users.

You can add the following columns to batch view.

l ExternalGroupId
l ExternalBatchId
l TransactionId
l TransactionType

Display and name additional Verifier columns: SQL Server

To display additional Verifier columns from a SQL database, in Microsoft SQL Server Management Studio, in
your BIC database, modify and execute any of the following commands.

l External group ID
exec sp_SetGlobalApplicationSetting
'SysAppBatchColumnExternalGroupId', '[Column header name, for example
User Group]', True

l External batch ID
exec sp_SetGlobalApplicationSetting
'SysAppBatchColumnExternalBatchId', '[Column header name, for example
Batch Group]', True

l Transaction ID
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionId',
'[Column header name, for example Transaction]', True

l Transaction type
exec sp_SetGlobalApplicationSetting
'SysAppBatchColumnTransactionType', '[Column header name, for example
Transaction Type]', True
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Display and name additional Verifier columns: Oracle

To display additional Verifier columns from anOracle database, from the SQL*Plus or ORACLE Management
Console, in your BIC database, execute any of the following commands.

l External group ID
exec sp_SetGlobalApplicationSetting
('SysAppBatchColumnExternalGroupId', '[Column header name, for example
User Group]', 1)

l External batch ID
exec sp_SetGlobalApplicationSetting
('SysAppBatchColumnExternalBatchId', '[Column header name, for example
Batch Group]', 1)

l Transaction ID
exec sp_SetGlobalApplicationSetting ('SysAppBatchColumnTransactionId',
'[Column header name, for example Transaction]', 1)

l Transaction type
exec sp_SetGlobalApplicationSetting
('SysAppBatchColumnTransactionType', '[Column header name, for example
Transaction Type], 1)

Display additional Web Verifier columns

The PostImportBatch event in the project script displays additional Web Verifier columns.
For more information on the event, see “PostImportBatch” in theBrainware Intelligent Capture Scripting Help.

To display additional columns inWeb Verifier, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, open the
Web.config file in a text editor.

2. Search for the following elements and set the visible attribute to true for the columns you want
to display.

l externalGroupIdColumn
l externalBatchNameColumn
l transactionIdColumn
l transactionTypeColumn

3. Save and close the file.
4. Restart any open browser sessions.

Change the Web Verifier column names

To change the display names for any additional columns inWeb Verifier, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server\bin\resources\[language
code] directory, open theBrainware.Verifier.WebClient.resx file in a text editor.

2. Search for the following <data name=> elements.
l TEXT_EXTERNALBATCH_NAME
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l TEXT_EXTERNAL_GROUP_ID
l TEXT_TRANSACTION_ID
l TEXT_TRANSACTION_TYPE

3. Set the <value> attributes with the names you want to display.
4. Save and close the file.
5. Restart any open browser sessions.

Configure global application settings
To configure global application settings, complete the following tasks as necessary.

1. Optional. Configure workflow history reporting for SQL Server or Oracle.
2. Optional. Disable batch deletion for SQL Server or Oracle.
3. Optional. Modify the URL expiration time for SQL Server or Oracle.

About workflow history reporting
You can activate the workflow history reporting for documents, fields, table cells, classification, learning, and
OCR and document separation. Changing these settings takes immediate effect and applies to all users.

Configure workflow history reporting: SQL Server

To configure workflow history reporting for SQL Server, in Microsoft SQL Server Management Studio, in your
BIC database, execute any of the following commands.

l For documents
exec sp_SetGlobalApplicationSetting
'SysAppHistoryReportingActivatedForDocument', 'True', True

l For fields
exec sp_SetGlobalApplicationSetting
'SysAppHistoryReportingActivatedForField', 'True', True

l For fields and table cells
exec sp_SetGlobalApplicationSetting
'SysAppHistoryReportingActivatedForTableCell', 'True', True

l For classification
exec sp_SetGlobalApplicationSetting
'SysAppHistoryReportingActivatedForClass', 'True', True

l For OCR and document separation
exec sp_SetGlobalApplicationSetting
'SysAppHistoryReportingActivatedForPage', 'True', True

l For learning
exec sp_SetGlobalApplicationSetting
'SysAppHistoryReportingActivatedForLearning', 'True', True
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Configure workflow history reporting: Oracle

To configure workflow history reporting for Oracle, in SQL*Plus or Oracle Management Console, in your BIC
database, execute any of the following commands.

l For documents
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForDocument', 'True', 1)

l For fields
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForField', 'True', 1)

l For fields and table cells
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForTableCell', 'True', 1)

l For classification
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForClass', 'True', 1)

l For OCR and document separation
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForPage', 'True', 1)

l For learning
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForLearning', 'True', 1)

About disabling batch deletion in Runtime Server and Designer
You can disable batch deletion in Runtime Server and Designer. Changing these settings takes immediate
effect and applies to all users.

Disable batch deletion: SQL Server

To disable batch deletion for SQL Server, in Microsoft SQL Server Management Studio, in your BIC database,
execute any of the following commands.

l For Designer
exec sp_SetGlobalApplicationSetting
'SysAppBatchDeletionDisabledInDesigner', 'True', True

l For Runtime Server
exec sp_SetGlobalApplicationSetting
'SysAppBatchDeletionDisabledInRTS', 'True', True

Disable batch deletion: Oracle

To disable batch deletion for Oracle, in SQL*Plus or Oracle Management Console, in your BIC database,
execute any of the following commands.

l For Designer
exec sp_SetGlobalApplicationSetting
('SysAppBatchDeletionDisabledInDesigner', 'True', 1)

l For Runtime Server
exec sp_SetGlobalApplicationSetting
('SysAppBatchDeletionDisabledInRTS', 'True', 1)
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About modifying the URL expiration time forWeb Verifier
You canmodify the URL expiration time forWeb Verifier. Changing these settings takes immediate effect and
applies to all users.

Modify the URL expiration time: SQL Server

Tomodify the URL expiration time for SQL Server, in Microsoft SQL Server Management Studio, in your BIC
database, complete the following step.

l Execute the following command, specifying the expiration time in seconds for the second
parameter.
exec sp_SetGlobalApplicationSetting
'SysAppUrlSignatureExpirationPeriod', '300', True

Modify the URL expiration time: Oracle

Tomodify the URL expiration time for Oracle, in SQL*Plus or Oracle Management Console, in your BIC
database, complete the following step.

l Execute the following command, specifying the expiration time in seconds for the second
parameter.
exec sp_SetGlobalApplicationSetting
('SysAppUrlSignatureExpirationPeriod', '300', 1)

Configure BIC security
To configure BIC security, review the following topics and complete the tasks as necessary.

1. File system security
2. Recommended accounts and groups
3. Configure access to project data
4. About the service account on a domain network
5. About the service account for systemmonitoring
6. About the service account for email importing
7. About INI file encryption
8. Encrypt a password for a database connection string
9. About user password encryption
10. Change the hashing algorithm
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File system security
Although BIC provides application-level security, the BIC applications rely on the integratedWindows file
system security to control access to application and project data in SDP, DAT, andWDC files.
BIC uses a combination of shared and file and directory permissions to control the access of users, groups,
and applications to directories and files.

The following table lists the available file permissions.

File
Permission

Access Granted

Read Allows the user or group to read the file and view its attributes, ownership, and
permissions.

Write Allows the user or group to overwrite the file, change its attributes, and view its ownership
and its permissions.

Read and
Execute

Allows the user or group to execute the file.
Includes the Read permissions.

Modify
(CHANGE)

Allows the user or group to modify and delete the file.
Includes the Read, Write, and Read and Execute permissions.

Full Control Allows the user or group to change the files permissions and to take ownership of the file.
Includes all other file permissions.

The following table lists the available directory permissions.

Directory
Permission

Access Granted

Read Allows the user or group to view the files, folders, and subfolders of the parent folder and to
view the folder attributes, ownership, and permissions.

Write Allows the user or group to create new files and folders within the parent folder, view folder
ownership and permissions, and change folder attributes.

List Folder
Content

Allows the user or group to view the files and subfolders in the folder.

Read and
Execute

Allows the user or group to navigate through all files and subfolders.
Includes the Read and List Folder Contents permissions.

Modify Allows the user to delete the folder.
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Directory
Permission

Access Granted

(CHANGE) Includes theWrite and Read and Execute permissions.

Full Control Allows the user or group to change the folder permissions and to take ownership of the
folder.
Includes all other folder permissions.

Recommended accounts and groups
To control access to BIC project data, we recommend a combination of Discretionary Access Control (DAC)
and Role-based Access Control (RBAC).
The DAC model allows the system administrators to control which users can access objects and resources
and the operations they can perform.

The RBAC model, also known as non-discretionary model, grants access based on the rights and
permissions of roles and groups. The users inherit their rights and permissions from their assigned roles and
groups.

The following table lists the groups and accounts recommended for each BIC implementation.

Group /
Account
Name

Purpose

BIC
Project
Users

Global group containing all users designated as BIC project designer or data verifier. Add this
group to the BIC Users group.

BIC Admin Global group containing all users designated as a BIC system administrator. Add this group to
the BIC group on all RTS servers and RTS remote administration workstations.

BIC Local group used to grant access to local BIC resources. Create this group on all RTS server
and RTS remote administration workstations.

BIC Users Local group used to grant access to the project directory. Create this group on the BIC server
on which the project directory resides.

BIC
RTSsvc

Service account used to start the BIC service manager. Add this user to the BIC Admin group
and the local administrators group on all BIC servers and remote administration workstations.

The following table lists the groups and accounts, assigned permissions, and the directories and objects on
which you need to apply the permissions for each BIC implementation.
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Group / Account Name Permission Type:
Shared

Permission
Type: NTFS

Directory/Objects Assigned
On

Brainware Intelligent
Capture

Full Control Full Control C:\Program Files\[company]\
[ProjectName]

Brainware Intelligent
Capture Users

Change Modify C:\Program Files\[company]\
[ProjectName]

Configure access to project data
BIC uses a hierarchical file structure to store project-related data, where the project directory is at the highest
level.
All BIC components including services, applications, license engines, and users need appropriate access
rights to the project directory and its subfolders.

To configure the access rights to the BIC project directory, complete the following steps.

1. InWindows Explorer, right-click your projects directory and then click Properties.
2. In theProperties dialog box, on theSharing tab, click Advanced Sharing.
3. In theAdvanced Sharing dialog box, select Share this folder.
4. In theShare name box, type a name for the share and then click Permissions.
5. In thePermissions for Projects dialog box, complete the following substeps.

1. Click Add.
2. In theSelect Users, computers, Service Accounts or Groups dialog box, in the

Enter the object names to select field, type the local BIC group name and click OK.
3. Repeat the previous steps to add the local administrators and BIC users group names.
4. For the local BIC group and the local administrators group, select Full Control.
5. For the local BIC users group, select Change.
6. Select theEveryone group, click Remove and then click OK.

6. In theProperties dialog box, on theSecurity tab, complete the following substeps.
1. Add the local BIC group and the local administrators group with Full Control

permission.
2. Add the local BIC users group withChange permission.
3. Select theEveryone group, click Remove and then click OK.
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About the service account on a domain network
The Runtime Server service utilizes aWindows service tomanage the Runtime Server instances and the
document processing.

When running BIC onmultiple servers located on a domain network, we recommend assigning a domain user
to the Runtime Server service against theWindows service. This allows BIC to communicate with all servers
running the service across the domain.

The service account, used in BIC, needs permissions for any file or directory shares across the servers to
allow the Runtime Server service to access all project-related files.

Note: Do not use the service account to log into the system, either locally or through Remote Desktop. You
can configure the Security Settings for the “Deny log on locally” and “Deny log on through Remote Desktop
Services” policies inWindows on the system running the services.

About the service account for system monitoring
You can use the SystemMonitoring service to send emails to selected users for any Runtime Server errors or
warnings.

The service user account used for SystemMonitoring needs sufficient rights on the server and domain to
send emails.

About the service account for email importing
BIC provides the ability to import emails, automatically download emails from amailbox, and import the
emails into the BIC system. The Runtime Server service needs sufficient access rights to access the
mailbox and to download emails.

About INI file encryption
BIC allows password encryption in INI files for database and SAP connection strings by using RSA
encryption. RSA encryption requires a public and a private key.

For more information, see “Password encryption for database connection strings” in theBrainware Intelligent
Capture Scripting Help.

Encrypt a password for a database connection string
Password encryption in CONFIG files is optional, but highly recommended. To provide an encrypted
password for the database connection in a configuration file, complete the following steps.

1. In the [Installation path]\Brainware Intelligent Capture\bin directory, create a new batch file
and give it a meaningful name, such as CreateEncryptedPassword.bat.

2. Copy one of the following options to the batch file, replacing MyPassword with the password you
want to encrypt.

Note:
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Themaximum character length for a password to encrypt usingRSA-1024 is 30.

Themaximum character length for a password to encrypt usingRSA-3072 is 280.

l To encrypt the password using the internal RSA-3072 key, use the following option.

DstCrypt.exe /text "MyPassword" >> EncryptedPW_
InternalKeys3072.txt

l To encrypt the password using the internal RSA-1024 key, use the following option.

DstCrypt.exe /text "MyPassword" /keysize "1024" >> EncryptedPW_
InternalKeys1024.txt

3. Save and close the file.
4. InWindows Explorer, double-click the batch file.
5. From [Installation path]\Brainware Intelligent Capture\bin, openEncryptedPassword.txt in a

text editor and copy the encrypted password to the clipboard.
6. Open the required configuration file in a text editor.
7. Search for the <connectionStrings> element.
8. In the <add name> element, set password as an asterisk.

Example

<add name="Entities" Password=*>

9. In the <appSettings> element, add a line with your encrypted password according to the
following example.

Example

<appSettings>
<add key="EncrPwd" value="The_encrypted_Password"/>
</appSettings>

10. Save and close the file.

About user password encryption
For security reasons and to ensure unfeasibility of password decryption, user passwords are encrypted using
a one-way hashing algorithm.

BIC stores only the hash values in the database to authenticate the user.

The following hashing algorithms are available.

l SHA-256 (default value)

l SHA-512
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Note:
If the hashing algorithm is changed, the system updates the database with the recalculated hash value as
soon as the user logs in to a BIC application.

Change the hashing algorithm

To change the hashing algorithm, complete one of the following steps.

Note:
Formore information about the possible hashing algorithms, see About user password encryption.

l For aSQL Server database, inMicrosoft SQL Server Management Studio, in your BIC
database, update the following commandwith the desired hashing algorithm and then execute the
command.

exec sp_SetGlobalApplicationSetting 'SysAppHashingAlgorithm', '
[hashing algorithm]', True

Example

exec sp_SetGlobalApplicationSetting 'SysAppHashingAlgorithm', 'SHA-
512', True

l For anOracle database, from theSQL*Plus or ORACLE Management Console, in your BIC
database, update the following commandwith the desired hashing algorithm and then execute the
command.

exec sp_SetGlobalApplicationSetting ('SysAppHashingAlgorithm', '
[hashing algorithm]', 1)

Example

exec sp_SetGlobalApplicationSetting ('SysAppHashingAlgorithm', 'SHA-
512', 1)

Configure BICRuntimeComponents
To configure BIC runtime components, review the following topics and complete the tasks as necessary.

1. About RTS Remote AdministrationMMC
2. Configure the Runtime ServiceManager service
3. Configure the RTS Remote AdministrationMMC Snap-in
4. Configure the email import feature in Microsoft Outlook
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About RTSRemote AdministrationMMC
Before you can use BIC, youmust configure the Runtime ServiceManager (RTS).

The RTS Remote AdministrationMicrosoft Management Console (MMC) snap-in enables you to start and
stopmultiple Runtime Servers remotely from a single workstation on the network. The BIC installation
creates a default console, called Runtime Server Administration that you can use to configure the RTS
Remote AdministrationMMC snap-in.

Configure the Runtime ServiceManager service
To configure the Runtime ServiceManager service, complete the following steps.

Prerequisite
Verify that the BIC RTSsvc domain user exists.

1. Log in toWindows using an account with administrator rights.
2. InWindows Services, right-click theBrainware Intelligent Capture Runtime Service Manager

service and then click Properties.
3. In theBrainware Intelligent Capture Service Manager Properties dialog box, on theGeneral

tab, set theStartup type according to your needs.
4. On the Log On tab, select This account and then click Browse.
5. In theSelect User dialog box, click Locations.
6. In the Locations dialog box, select the domain that has the required account and then click OK.
7. In theSelect User dialog box, in theEnter the object name to select box, type the domain user

name, such as BIC RTSsvc, click Check Names, and then click OK.
8. Type the password for the user in thePassword and theConfirm password fields and then click

OK.

Configure the RTSRemote AdministrationMMCSnap-in
To configure the snap-in, complete the following steps.

1. Verify that theBrainware Intelligent Capture Runtime Service Manager service is running.
This lets you connect by MMC to themachine.

2. Identify one free configurable port available in any TCP/IP network or the Internet across firewalls.

Note: The default port number is 50607.

3. Verify one of the following prerequisites.
l The administration workstation resides on the same LAN segment as the RTS services.
l In a sub-netted network, a name resolution system is in place to allow clients on one
subnet to locate resources on another subnet.

4. Start Brainware Intelligent Capture Runtime Service.
5. In theRuntime Server Administration window, in the left pane, right-click Runtime Server

Administration and click New RTS Group.
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6. In theNew Group dialog box, type a group name and click OK.
7. Open theRuntime Server Administration node, right-click the newly created group, and then

click New Machine.
8. In theGroup Management dialog box, complete the following substeps.

1. From theDomains list, select the required domain and then click Search.
2. In the left pane, select the requiredmachines, click >> and then click OK.

9. In theRuntime Server Administration window, complete the following substeps.
1. In the left pane, right-click the newly addedmachine and then click License.
2. In the License Information dialog box, verify or change the license path and then click

OK.
3. In the left pane, right-click the newly addedmachine and then click New > RTS

Instance.
4. In theNew RTS Instance dialog box, type an instance name and then click OK.

Configure the email import feature in Microsoft Outlook
You can optionally configure BIC to import emails fromMicrosoft Outlook. To configure the email import
feature, complete the following steps.

1. InWindows Control Panel, click Mail.
2. In theMail dialog box, click Add.
3. In theNew Profile dialog box, type RTS_Import and then click OK.
4. In theAdd New Account dialog box, selectManually configure server settings or additional

server types and then click Next.
5. In theChoose Service page, selectMicrosoft Exchange or compatible service.
6. In theServer Settings page, complete the following substeps.

1. In theServer field, type the name of your Microsoft Exchange Server.
2. Clear theUse Cached Exchange Mode check box.
3. In theUser Name field, type the user name and then click Next.

7. To create the account and close the wizard, click Finish.
8. In the [Installation path]\Brainware Intelligent Capture directory, create a new batch file that

contains the following line and then run the file.
DstHost.exe /TestMailUI

9. In theOutlook login dialog box, complete the following substeps.
1. In theUser name field, type [domain name]\[user name] and in thePassword

field, type the password.
2. Select Remember my credentials and then click OK.

10. From the [Installation path]\Brainware Intelligent Capture\bin\Log directory, open the latest I_
[YYYYMMDD]_DistillerRuntimeServiceHost_[PID].log file and check for a success or error
message, such as Managed to open the folder 'Inbox'.

11. In the [Installation path]\Brainware Intelligent Capture directory, create a new batch file that

DstHost.exe /TestMail
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Note: This writes amessage to the log file, but does not open theOutlook login dialog box.

About the desktop heap size
If you runmore than 10 concurrent Web Verifier sessions or Runtime Service instances, modify theWindows
desktop heap size to prevent internal memory issues.

Modify the desktop heap size
Tomodify the desktop heap size, complete the following steps.

1. Start Windows Registry Editor and back up the registry settings.
2. Navigate toHKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session

Manager\SubSystems.
3. In the right pane, right-click theWindows entry, and then click Modify.
4. In theEdit String dialog box, in the editing field, modify the third argument of theSharedSection

parameter, which defines the desktop heap size.

Note: For information about the appropriate heap size, see Ideal desktop heap size.

5. Reboot the server.

Ideal desktop heap size
Determine the ideal desktop heap size with the following table.

Number of concurrent Web Verifier or Runtime Server instances Desktop heap size in KB

1 - 10 Operating system default value

11 - 24 1024

25 - 36 1536

37 - 48 2048

49 - 60 2560

61 - 72 3072
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About logging
The standard Runtime Server log files include system level resource information and, in case of a system
failure, special error logs.

Application log files
Each log file contains the following information.

Entry Nr. Description

1 Type of message such as Info, Warning, or Error

2 Severity of message

3 Time logged

4 Process ID (PID)

5 Overall used/available physical memory in KB

6 Overall used/available virtual memory in KB

7 Used physical/virtual memory by this RTS instance in KB

8 Number of process handles used by this RTS instance

9 GDI resources/UserObjects used by this RTS instance

10 Message text

The following log files are available in the [Installation path]\Brainware Intelligent Capture\bin\Log directory.

Log file
name

Description

V_*.log Verifier messages including custom script errors.

VA_*.log Advanced Verifier messages.

VL*.log Local Verifier messages.

H_*.log Runtime Server Host (DstHost) messages for a single RTS instance.

L_*.log Learnset Manager messages, such as when the user triggers document learning, or backs up
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Log file
name

Description

the learnset.

D_*.log Designer messages including script errors.

U_*.log Web Verifier and external application messages.

S_*.log Service Manager (DstMgr) messages, such as start and end of service, restart, or failures.

I_*.log Component log files for all applications.

M_*.log System Monitoring (DstEvent) messages. Holds all system messages and can log error
messages across all server machines and hosts.

Error log files
In the event of system or application failures, BIC creates an additional error log file namedC_<Process ID>_
yyyymmdd.log.

OCRengine languages
The following table lists the OCR engine languages supported by FineReader 10 and 11.

Supported OCR languages

Bulgarian Italian Romanian

Chinese Simplified * Japanese * Russian *

Chinese Simplified + English * Japanese + English * Slovak

Czech Korean * Slovenian

Danish Korean + English *

Note: Only with FineReader 11

Spanish

Digits KoreanHangul Swedish

Dutch Latvian Thai *
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Supported OCR languages

English Lithuanian Turkish

Estonian Norwegian Ukrainian *

Finnish NorwegianBokmal Vietnamese *

French NorwegianNynorsk CMC7

German Polish E13B

Greek * Portuguese Brazilian

Hungarian Portuguese Standard

*: These languages require support of double byte and extended ASCII character sets. To avoid performance
loss, do not usemore than one DBCS language in a project.

Available OCREngines
The following optional OCR engines are available, but require separate licensing.

Cleqs Barcode Engine

Reads handwritten andmachine-printed data and bar code information. It reads 18 types of bar codes.

FineReader10 OCR Engine

Supports Chinese, Korean and Japanese characters in addition to English, German, Italian, French, and
Spanish characters. Converts paper-based or scanned images to editable text.

FineReader11 OCR Engine

Supports OCR of several additional languages and features several improvements in the OCR output quality
relative to FineReader 10.

l Receipt Mode
l Improved auto-orientation
l ImprovedOCR of amounts with leading or trailing asterisks
l ImprovedOCR of amounts with leading dollar sign

Kadmos 5 OCR Engine Client Edition

Used for handwriting recognition.
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Kadmos 5 OCR Engine Server Edition

A server edition capable of processing for multiple users and onmultiple processors is available by additional
licensing.

QualitySoft Barcode Engine

Supports both grayscale and color images and recognizes 19 different bar code types.

About automated update
You can enable your system to automate updates to your BIC workstations. The automated update feature
compares the build level files in the shared network directory and local update directory, and if required, an
update performs before the application starts.

If you did not configure the automated update feature during the installation process, you can configure the
featuremanually.

Note: This feature is not available for all versions of BIC. For details, refer to the appropriateBrainware
Intelligent Capture Release Notes.

Modify the batch file
Tomodify the batch file to automate updates, complete the following steps on each BIC server and
workstation.

Prerequisite
Determine a shared network directory on a server to incorporate the update files. All BIC workstations must
have access permissions to this directory.

1. From the [Installation path]\Brainware Intelligent Capture\bin directory, open the
AutoInstall.bat file in a text editor.

2. Search for the following line.
SET SHAREDNETFOLDER
=\\YourNetworkInstallServerName\YourInstallShareName

3. Modify \\YourNetworkInstallServerName\YourInstallShareName to your shared
network directory.

4. Save and close the file.

Modify the application shortcuts for Verifier and Designer
To set up Designer and Verifier to run the automated update feature each time they start, complete the
following steps.

1. In theWindows start menu, right-click theDesigner application and then click Properties.
2. On theShortcut tab, in the Target field, changeDstDsr.exe toDstDsr_AutoUpdate.bat and then

click OK.
3. In theWindows start menu, right-click theVerifier application and then click Properties.
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4. On theShortcut tab, in the Target field, changeDstDsr.exe toDstDsr_AutoUpdate.bat and then
click OK.

Automate Runtime Server updates
To configure the automated update for Runtime Server, you can create aWindows task.
InWindows Task Scheduler, create a new task that executes the following steps.

1. To stop the RTS service, in [Installation path]\Brainware Intelligent Capture\bin directory, runStop
RTS running as NT Service.bat.

Note: Verify that RTS is not actively processing documents before you stop the service.

2. In [Installation path]\Brainware Intelligent Capture\bin directory, runAutoInstall.bat
3. To start the RTS service, in [Installation path]\Brainware Intelligent Capture\bin runStart RTS

running as NT Service.bat.

About port configuration
In case of a conflict in port assignments or for the purpose of firewall configuration, you can change the port
the Runtime Server uses for the TCP/IP communication channel.

The Runtime Server service, the instance processes, and theMMC use the same Port registry setting. The
default port is 50607.

Configure a different port for Runtime Server
To configure a different port for Runtime Server, complete the following steps.

1. InWindows registry, complete one of the following substeps.
l For a 32-bit machine, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Hyland_
BW\Services.

l For a 64-bit machine, navigate to HKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Hyland_BW\Services.

2. In the right pane, right-click and then click New > DWORD (32-bit) Value.
3. In theName field, type Port.
4. Right-click thePort key and then click Modify.
5. In theEdit DWORD (32-bit) Value dialog box, in theValue data field, type the number of an

available port and then click OK.
6. Restart Brainware Intelligent Capture Runtime Server service.
7. Repeat the previous steps on all BIC servers.
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File permissionmatrix
The following tables list the various file permissions used within BIC.

Role/Group Description

Administrators Users with full access rights to all application modules and features.

Developers Users that develop, maintain, and enhance projects.

Learnset
Manager

Typically one single user responsible for maintaining the project learnsets.

Advanced
Verifiers

Several users responsible for identifying documents for improvements to the project
learnset.

Standard
Verifiers

Users responsible for document correction.

RTS Service
User

The service account responsible for running the service for automatic document
processing.
Configured only on the server machines.

The following table lists the required NTFS permissions.

Directory Groups Full
Control

Modify Read &
Execute

List
Folder
Content

Read Write No
Access

License
Share

Administrators

Developers

Learnset
Manager

Advanced

Verifiers

Standard
Verifiers

RTS Service
User

- - x x x x -

Common
Folder

Administrators x x x x x x -
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Directory Groups Full
Control

Modify Read &
Execute

List
Folder
Content

Read Write No
Access

Developers

Learnset
Manager

Advanced

Verifiers

Standard
Verifiers

RTS Service
User

- - - - - - x

Global
Project

Administrators

Developers

Learnset
Manager

RTS Service
User

x x x x x x -

Advanced
Verifiers

Standard
Verifiers

- - x x x - -

Local
Project

Administrators

Developers

x x x x x x -

Learnset
Manager

RTS Service
User

Standard
Verifiers

- - - - - - x

Advanced
Verifiers

x x x x x x -
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Directory Groups Full
Control

Modify Read &
Execute

List
Folder
Content

Read Write No
Access

Local
Learnset

Administrators

Developers

x x x x x x -

Learnset
Manager

RTS Service
User

Standard
Verifiers

- - - - - - x

Advanced
Verifiers

x x x x x x -

Global
Learnset

Administrators

Developers

Learnset
Manager

RTS Service
User

x x x x x x -

Advanced
Verifiers

Standard
Verifiers

- - x x x x -

ASE Pool Administrators

Developers

RTS Service
User

x x x x x x -

Learnset
Manager

Advanced
Verifiers

Standard
Verifiers

- - x x x - -
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Directory Groups Full
Control

Modify Read &
Execute

List
Folder
Content

Read Write No
Access

ASSA
CSV File

Administrators

Developers

RTS Service
User

x x x x x x -

Learnset
Manager

Advanced
Verifiers

Standard
Verifiers

- - - - - - x

Web.config options and associated resource file parameters
This topic lists Web.config file options you canmodify to enable, disable, or customize features.

For more information about the event options, refer to theBrainware Intelligent Capture Scripting Guide.

Option Description

ADOCommandExecutionTimeOut Defines the timeout, in seconds, for executing stored procedures
in the database.
Possible values
Any valid integer

AllowAccessToDocumentsToIndexOnly For more information, see About navigation to documents for
indexing.
Possible values
True: Enable navigation to indexable documents only

False: Enable navigation to out-of-workflow documents.

The default value is False.

BatchViewPageSize Defines the number of batches per page that display in theWeb
Verifier batch list.
Possible values
Any valid integer

The default value is 20.
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Option Description

client script mode Defines the parameter to compress the script file that is sent to
the browser from the server.
Possible values
Test: Testing or debugging of Web Verifier client side script on
browser.

Release: Used in production environment to minimize the file
size of the client side script that assists in improving page loading
performance.

cacheScripts in the <clientScript>
element

Defines the Ext. script caching behavior.
Possible values
True: Used in Ext.Loader.setConfig parameter to enable
caching.

False: Used in Ext.Loader.setConfig parameter to disable
caching.

ClientSideDocumentCacheSize Defines the number of pages to cache in the current document.
Possible values
Any valid integer

The default value is 0.

connectionStrings The database connection string.

convertedScriptCaching Add this configuration in the <project.controller>\<project> node
along withmpdDistance andmpdThreshold.
Possible values
True: Enables script conversion caching to reduce initial project
loading time.

False: Disables script conversion caching to slow down initial
project loading time.

The default value is True.

Note: You also need to set this value to "true" in the
Brainware.system.project.exe.config setting to enable script
conversion caching.

DialogWidth Defines the default width, in pixels, of message boxes in Web
Verifier.
Possible values
Any valid integer
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Option Description

The default value is 400.

document cacheSize in the
<document.controller> element

Specifies the number of workdoc objects to pre-load. This
accelerates opening documents within the batch.

You cannot disable pre-loading, but minimize the number of pre-
loaded documents to 2, that means one current and one pre-
loaded.
Possible values
Any valid integer

The default value is 5.

document maxPagesToPreload in the
<document.controller> element

Defines the number of document pages to pre-load.

First and last pages always pre-load, and remaining cache slots
fill with pages that have field candidates starting from the lower
index.

The following actions take place on page images when a
document loads in the background.

l Pre-load the page
l Convert the page to PNG
l Save the page to the database

Possible values
Any valid integer

The default value is 5.

DocumentViewPageSize Defines the number of folders for Verifier to display in the
document tree view when using Show Selected Batch mode.
Additional batches display in subsequent navigation panels.
Possible values
Any valid integer

The default value is 10.

EnableProfiler Whether to enable theWeb Verifier profiler.

The profiler collects and records the duration of user actions,
such as commands and their internal sub-operations.
Possible values
True / False

The default value is False.



Brainware Intelligent Capture Installation Guide

60

Option Description

externalGroupIdColumn Whether the external group ID column displays in Web Verifier.
Possible values
True / False

The default value is False.

externalBatchNameColumn Whether the external batch name column displays in Web
Verifier.
Possible values
True / False

The default value is False.

focusChanged Whether to enables the focusChanged event for fields in the
verification view.

The event triggers when the user presses the Enter key in a field.

The setting has no effect on the FocusChanged event if the
<mouseClicked> attribute is set to true.
Possible values
True / False

The default value is True.

HelpLink Links to Web Verifier Help.

httpHeaderBasedSso Controls the single sign-on (SSO) user authentication mode.

login header in the
<httpHeaderBasedSso> element

Corresponds to the HTTP header attribute name that contains
the SSO authenticated user name.
The SSO service uses this attribute to send the user name.

Enabled in the <httpHeaderBasedSso>
element

Whether to use theWeb Verifier SSO feature.
Possible values
True / False

The default value is False.

sessionHeader in the
<httpHeaderBasedSso> element

The provider-dependent name of the HTTP header that the SSO
service uses to send the user session ID.

inactiveUserTimeout Unchangeable attribute.

Note: This attribute does not control the user session timeout.
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Option Description

The <sessionState Timeout> parameter controls the
user session timeout.

inspectionTimeOut Unchangeable attribute.

Note: This attribute does not control the user session timeout.
The <sessionState Timeout> parameter controls the
user session timeout.

instanceName The instanceName value displays in the batch list column “Last
Module".

Note: The instanceName valuemust be unique across all
installedWeb Verifier servers accessing the same database.

itemCopied Whether to enable the itemCopied event.
Possible values
True / False

The default value is False.

LanguageDisplayName_[ISO] Customizes the language display names in the language
selection menu.

Replace [ISO] by the three letter directory name in [Installation
path]\Brainware Intelligent CaptureWeb Server\Bin\Resources.
Example for Simplified Chinese
<add key="LanguageDisplayName_ZHO" value="中
文简体"/>

licensePath The location of the shared license file.
Possible values
Any valid path

The default value is [Installation path]\License\Runtime.lic.

level Defines the tracing level.
Possible values
DEBUG: Trace all information and error messages.

ERROR: Trace error messages only.
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Option Description

loadInSeparateProcess Unchangeable attribute.

mouseClicked Whether to enable the mouseClicked event on fields and tables
in the verification view in indexing mode.
Possible values
True / False

The default value is False.

pathToProjectExe The location of the Designer program
Brainware.System.Project.exe. In typical installations, it is not
required to modify this value.
Possible values
A valid non-UNC path ending with a “\”.

The default value is [Installation path]\Brainware Intelligent
Capture\Bin\.

ReinitScriptEngineAfterScriptErrors Whether to recover the script engine after a script error in Web
Verifier.
Possible values
True / False

The default value is False.

remoteObjectRenewalTimeout Defines, in seconds, the time to lapse before renewing remote
object references. The lower the number the faster unused
objects free memory. Increase this value in the event of errors
caused by long-running commands, such as field validation.
Possible values
Any valid integer more than or equal to 30.

The default value is 30.

SavePageImageToDatabase Specifies if page images extracted from document file blobs
needs to be saved back to the database.
Possible values
True / False

timeout in the <sessionState> element Defines, in minutes, the amount of time a user can be inactive
before the session ends.

Specify a value less than that of the SSO session. For details,
see the product documentation of your SSO provider.
Possible values
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Any valid integer.

The default value is 20.

ShowExtendedErrorMessages Whether to enable stack trace information for Web Verifier error
messages.

Error messages display in the trace log file.
Possible values
True / False

The default value is False.

slogan A text message that displays on theWeb Verifier browser
header, such as corporate messages, announcements, or the
corporate slogan.
Possible values
The default value is an empty string.
Example
<verifier.webclient>

<company slogan="This is a slogan" />

SYSTEM_LONG_DATE_FORMAT The XML key available in each
Brainware.Verifier.WebClient.resx file located in [Installation
path]\Brainware Intelligent CaptureWeb Server\Bin\Resources\
[language code].
The key contains the date pattern for the last access date column
in the batch list for the respective language.

To use the default system date pattern, leave the value element
empty. The time format uses a 24-hour clock.

For Traditional and Simplified Chinese, use the date format in
the following example without any Chinese characters.
Example for Chinese
<data name="SYSTEM_LONG_DATE_FORMAT"

xml:space="preserve">

<value>yyyy-MM-dd, hh:mm:ss</value>

</data>

transactionIdColumn Whether the transaction ID batch column displays in Web
Verifier.
Possible values
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True / False

The default value is False.

transactionTypeColumn Whether the transaction type batch column displays in Web
Verifier.
Possible values
True / False

The default value is False.

tabPressed Whether to enable the tabPressed event on fields and tables in
the verification view in indexing mode.
Possible values
True / False

The default value is False.

tableCellSelected Whether to enable the tableCellSelected event.
Possible values
True / False

The default value is False.

usePath Possible values
True: Use the pathToProjectExe parameter.

False: Use the current directory instead of the pathToProjectExe
parameter.

The default value is True.

waitLoadTimeOut Defines the timeout for the initial loading of the project.exe.

About navigation to documents for indexing
Indexable documents are documents with states from enabled workflow input states. TheWeb.config option
AllowAccessToDocumentsToIndexOnly and theWeb Verifier option “Disable navigation to valid
documents” control the navigation to indexable documents.

Example

Workflow settings: 550 -> 700

A batch includes documents with states 550, 600, and 700.
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If you set AllowAccessToDocumentsToIndexOnly to True and activate the "Disable navigation to valid
documents" option inWeb Verifier, you cannot access documents with state 600 or 700.

Enable navigation to indexable documents
To enable navigation to indexable documents only, complete the following steps.

1. From the [Installation path]\Brainware Intelligent CaptureWeb Server directory, openWeb.config
in a text editor.

2. Search for <appSettings>.
3. Add the following line.

<add key="AllowAccessToDocumentsToIndexOnly" value="true" />

4. Save and close the file.
5. InWeb Verifier, activate theDisable navigation to valid documents option.

Registry options
You can create or modify the following keys in theWindows registry to enable, disable, or customize features.

Key Description

ErrorTraceDir Provides the possibility to change the component log file location. The
setting does not affect the core product log file location.

HideBatchReleaseDialog Allows you to enable or disable the Batch Release dialog box within
Verifier, where the workflow does not require prompting users to the next
task. The registry value determines the next action carried out by users.
The default action of the Batch Release dialog box is to verify the next
invalid batch. When BIC suppresses the dialog, this value is maintained.
To change to a different action, use the Batch Release dialog box once,
then change the setting accordingly and click OK.

The default value is 0.

ErrorTrace - All Defines the trace level.
The default value is 1.

MaximumDiskspaceUsageMB Defines the disk space in MB allocated for component level logs.

TotalDaysToKeepFiles Defines the number of days the BIC server retains the component log files.

Create the registry key ErrorTraceDir
To create the registry key, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.
l For a 32-bit machine, navigate toHKEY_LOCAL_MACHINE\SOFTWARE\Hyland_
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BW\ErrorTrace.
l For a 64-bit machine, navigate toHKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Hyland_BW\ErrorTrace.

2. In the right pane, right-click and then click New > String Value.
3. In theName field, type ErrorTraceDir and then click OK.
4. Right-click theErrorTraceDir key and then click Modify.
5. In theEdit String dialog box, in theValue data field, type the path and then click OK.

Note: The pathmust exist and the service account / user needs write permission to the path.

6. Restart all BIC applications and services.

Create the registry key HideBatchReleaseDialog
To create the registry key, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.
l For a 32-bit machine, navigate toHKEY_LOCAL_MACHINE\SOFTWARE\Hyland_
BW\Cedar .

l For a 64-bit machine, navigate toHKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Hyland_BW\Cedar.

2. In the right pane, right-click and then click New > DWORD (32-bit) Value.
3. In theName field, type HidebatchReleaseDialog and then click OK.
4. Right-click theHidebatchReleaseDialog key and then click Modify.
5. In theEdit DWORD (32-bit) Value dialog box, in theValue data field, complete one of the

following steps and then click OK.
l To display the confirmation screen, type zero: 0.
l To hide the confirmation screen, type 1.

6. Restart all BIC applications.

Modify the registry key ErrorTrace - All
Tomodify the value, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.
l For a 32-bit machine, navigate toHKEY_LOCAL_MACHINE\SOFTWARE\Hyland_
BW\ErrorTrace.

l For a 64-bit machine, navigate toHKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Hyland_BW\ErrorTrace.

2. In the right pane, right-click All and then click Modify.
3. In theEdit DWORD (32-bit) Value dialog box, in theValue data field, complete one of the

following steps and then click OK.
l To log only errors, type 1.
l To log only errors and warnings, type 2.
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l To log only errors, warnings, and information, type 3.

Create the registry keyMaximumDiskspaceUsageMB
To create the registry key, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.
l For a 32-bit machine, navigate toHKEY_LOCAL_MACHINE\SOFTWARE\Hyland_
BW\ErrorTrace .

l For a 64-bit machine, navigate toHKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Hyland_BW\ErrorTrace .

2. In the right pane, right-click and then click New > DWORD (32-bit) Value.
3. In theName field, type MaximumDiskspaceUsageMB.
4. Right-click theMaximumDiskspaceUsageMB key and then click Modify.
5. In theEdit DWORD (32-bit) Value dialog box, in theValue data field, complete one of the

following steps and then click OK.
l To deactivate the option, type zero: 0.
l Type the appropriate value in megabyte.

Create the registry key TotalDaysToKeepFiles
To create the registry key, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.
l For a 32-bit machine, navigate toHKEY_LOCAL_MACHINE\SOFTWARE\Hyland_
BW\ErrorTrace .

l For a 64-bit machine, navigate toHKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Hyland_BW\ErrorTrace.

2. In the right pane, right-click and then click New > DWORD (32-bit) Value.
3. In theName field, type TotalDaysToKeepFiles.
4. Right-click the TotalDaysToKeepFiles key and click Modify.
5. In theEdit DWORD (32-bit) Value dialog box, in theValue data field, complete one of the

following steps and then click OK.
l To deactivate the option, type zero: 0.
l Type the number of days.
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